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El aumento de la demanda energética por el crecimiento poblacional se estima 

que se duplicará en los próximos 20 años, motivo por el cual la inminencia de la 

transición energética hacia fuentes renovables es mucho más vigente 

actualmente. 

El hidrógeno como vector energético, así como la captura y almacenamiento del 

CO2 van a ser clave en cualquier estrategia de transición/decarbonización para 

cumplir los retos planteados por la EU para el año 2050. 

Pero hay un problema aun por resolver: la intermitencia estacional de las 

renovables requiere de un sistema de almacenamiento a gran escala temporal que 

las tecnologías de almacenamiento actuales no permiten.

Un aspecto clave para la explotación de este recurso energético es la capacidad 

de su almacenamiento masivo que, además, permita cargas y descargas que se 

ajusten a la demanda de energía  permitan la estabilidad de la red eléctrica.

Introducción

En el aspecto del almacenamiento, los yacimientos 

agotados y los acuíferos permitirán almacenar 

energía del orden de los TWh (Tera Watt-hora) 

durante largos periodos de tiempo, en la escala de 

los meses. De esta forma, es posible establecer 

estrategias de uso de energía a mediano y largo plazo 

haciendo viable el escalado de las tecnologías 

renovables.
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Pero, a diferencia de los hidrocarburos que se encuentran en el subsuelo en 

condiciones de estabilidad físico-química por millones de años, el hidrógeno 

o el CO2 apenas comenzarán su reacción con el medio ambiente del 

subsuelo cuando sean inyectados. Esto deja muchas incógnitas por resolver. 

Muchas de las cuales tendrán respuesta desde el punto de vista de la escala 

del poro. Por tal motivo el objetivo de este trabajo es la evaluar la 

factibilidad de modelar los fenómenos de transporte en medios porosos del 

subsuelo para el hidrógeno y el dióxido de carbono haciendo uso del 

COMSOL Multiphysics.

Introducción
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Antecedentes
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2008
• Modelling and 

simulation of 
Pore-Scale 
Multiphase fluid 
flow

• Pore-Network 
modelling / Lattice 
Boltzman / Monte 
Carlo / Molecular 
dynamics

2012
• Computations of 

Absolute 
Permeability on 
uCT images

• Mostaghimi / 
Blunt / Bijeljic

2012
• Digital Rock 

Physics 
Benchmarks Part I 
and II

• Andrä and others

2012
• X-ray imaging 

and analysis 
techniques for 
quantifying pore-
scale structure 
and processes in 
subsurface 
porous medium 
systems 

• Wildenshild / 
Sheppad

2013
• Pore-scale 

imaging and 
modelling

• Blunt / Bijeljic / 
Mostaghimi

2014
• Direct 

simulations of 
two-phase flow 
on micro-CT 
images of porous 
media and 
upscaling of pore-
scale forces 

• Raeini / Blunt / 
Bijeljic



Antecedentes
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2018
• Structural 

characterization 
and numerical 
simulations of 
flow properties of 
standard and 
reservoir 
carbonate rocks 
using micro-
tomography 

• Islam / Sassi

2019
• Pore-scale 

permeability 
prediction for 
Newtonian and 
non-Newtonian 
fluids 

• Eichheimer / 
Thielmann / 
Popov / Fujita / 
Kottwitz / Kaus

2019
• Rock properties 

from micro-CT 
images: Digital 
rock transforms 
for resolution, 
pore volume, and 
field of view 

• Saxena / Hows / 
Hofmann / Alpak / 
Dietderich / Appel 
/ Freeman / DJong

2021
• Estimating 

permeability of 
3D micro-CT 
images by 
physics-informed 
CNNs based on 
DNS 

• Gärttner / Alpak / 
Meier / Ray / Fran 

2021
• Pore Scale 

Investigation of 
Hydrogen 
Injection in 
Sandstone via X-
ray Micro-
tomography 

• Kumar / Al-Yaseri
/ Ghasemiziarani / 
Al-Bayati

2022
• Pore-scale 

modeling of 
complex 
transport 
phenomena in 
porous media 

• Chen / He / Zhao 
/ Kang / Li / 
Carmeliet / 
Shikazono / Tao



PROCESO PARA MODELADO GEOMETRÍAS DE MEDIOS POROSOS

Materiales y métodos
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Adquisición de 
muestra del 

subsuelo

Escaneo 3D de la 
estructura de la 

red de poros
mediante uCT

Rendenrizado de la 
geometría 3D para 

generación de 
malla en superficie

Importar malla
superficial a 
COMSOL y 

convertir en malla
de volumen o en

geometría

Simulación en
COMSOL



MUESTRAS DEL SUBSUELO

• Dos muestras geológicas de areniscas 
• SS-121 à Arenisca de cantera de permeabilidad de 66 mD

• AMPC2 à Arenisca de acuífero salino de permeabilidad de 775 mD

• Mini muestras en forma de cilindro (miniplug) para escaneo con uCT
• SS-121 à Diámetro miniplug de 3 mm

• AMPC2 à Diámetro minplug de 5 mm

Materiales y métodos

Mini muestras de arenisca geológicas para 

escaneo con micro-tomógrafo computarizado
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Sample ID Porosity Air permeability (mD) 
SS-121 21% 66 

AMPC2 23% 775 
 



ESCANEO DE MUESTRA GEOLÓGICA CON uCT

Materiales y métodos
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Montaje muestra en uCT

Adquisición de imágenes Reconstrucción

Roca 3D digital 



Selección de REV y segmentación

Materiales y métodos
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MÉTODOS DE RENDERIZADO DE IMAGEN 3D DE ROCA CON SOFTWARE DE uCT

Materiales y métodos
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PROBLEMAS DE RENDERIZADO DE GEOMETRÍAS COMPLEJAS

Materiales y métodos

Archivo de tamaño gigante

• 18 GB en disco

Simulation of transport phenomena in porous media to store H2 and/or CO2 capture 12

Mallas superficiales con millones de elementos

• 189 millones de vértices

• 63 millones de caras

SE REQUIERE ALTA CAPACIDAD DE MEMORIA RAM (128 GB)



PROBLEMAS DE IMPORTACIÓN DE ARCHIVO MALLA EN COMSOL

Materiales y métodos
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Mallas superficiales con millones de elementos

• 189 millones de vértices

• 63 millones de caras



PROBLEMAS DE IMPORTACIÓN DE ARCHIVO MALLA EN COMSOL
• Elementos de  baja calidad

• Intersección de caras

Materiales y métodos
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Mallas superficiales con millones de elementos

• 189 millones de vértices

• 63 millones de caras



PROBLEMAS DE IMPLEMENTACIÓN DE FÍSICA EN MODELO IMPORTADO

Materiales y métodos
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• Tiempos de cómputo mayores a a 60 

horas.

• Colapso total del ordenador



SOLUCIÓN AL PROBLEMA DEL TAMAÑO

Materiales y métodos

Volumen de interés (VOI) paralelepípedo 252x126x126
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Mallas superficiales con millones de elementos

• 189 millones de vértices

• 63 millones de caras

REV original 2000x2000x2000

Volumen de interés (VOI) cúbico 25x25x25



SOLUCIÓN PARA RENDERIZADO DE GEOMETRÍA 3D CON SOFTWARE LIBRE (FIJI y MeshLab)

Materiales y métodos
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Mesh file from uCT images of AMPC2 sample image using FIJI 

ROI definition 
Geometric shape Quadratic 
Dimensions 126x126 px (882x882 um) 

VOI definition Geometry shape 
Parallelepiped Most relevant for permeability study 
Dimensions 126x126x252 vx (882x882x1764 um) 

New folder creation Copy of the number of 2D images or slides 
the same as the length VOI length 

Importing image 
sequence 
in FIJI 

Open FIJI 
From import options 
selects 
Image Sequence… 

Browse for the create folder 
Click ok for importing the images 

• Click Ok button for 
importing the images 

Defining image 
length units Open Image menu Click on Properties… 

Change Pixel width value to 7 and 
the unit from pixel to um 

• Click Ok button 

Creating ROI 
Open Edit menu Open Selection options 

Click on Specify… 
• Change Width value to 126 

Change Height value to 126 
• Play with the X and 

Y coordinates 
to place the ROI 

Cropping images Open Edit menu Click on Crop 

Smoothing images Open Process menu 
Click on Smooth 
Hit Yes button on the 
pop-up window 

Repeat the previous step 
at least 3 times more 

Binary images Open Process menu Open Binary menu 

Click on Make Binary 
• Select Otsu on Methods list 

Select Light on Background 
list 
Activate Create new stack 

• Click Ok button 

Denoising 
Removing outliers Open Process menu and 

Noise options 

Click on Remove Outliers… 
• Select Bright on Which 

outliers list 
• Repeat for Dark 

outliers 

De-speckling Open Process menu and 
Noise options 

Click on De-speckle 
• Click on Yes button 

Surface mesh file 
generation 

Open File menu and 
Save as list Click on Wavefront.OBJ 

Check that the stack selected is the 
binarized images 
Change Resampling factor to 1 

• Click Ok button 
• Define a file name 

Click the Save 
button 

 



SOLUCIÓN PARA RENDERIZADO DE GEOMETRÍA 3D CON SOFTWARE LIBRE (FIJI y MeshLab)

Materiales y métodos
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Geometría renderizada con FIJI

Geometría mallada y limpia con MeshLab

Malla importada y funcional en COMSOL

AM
PC

2
SS

-1
21



CONDICIONES DE BORDE
• Dirichlet para la velocidad entrada de 0.001 m/s en el

modelo AMPC2
• Dirichlet para la velocidad entrada de 0.1 m/s en el

modelo SS-121
• Dirichlet en la salida a presión constante igual cero para 

ambos modelos.
• Paredes con condicion de deslizamiento (Según

estimación de número de Knudsen)
• Condición de simetría en borde laterales.

Materiales y métodos
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CASOS DE ESTUDIO PARA LUJO LAMINAR CON RÉGIMEN 

ESTACIONARIO 
Case # Parametric Sweep Parameter values Fixed parameter Geometry

1 Material H2 CO2 CH4 N2 He Vel_in: 1e-3 / slip walls AMPOC2
2 Material H2 CO2 CH4 N2 He Vel_in: 1e-3 / no slip walls AMPOC3
3 Velocity (m/s) 1e-4 1e-3 1e-2 0.1 0.5 1 Fluid: H2 AMPOC2
4 Velocity (m/s) 1e-4 1e-3 1e-2 0.1 0.5 1 Fluid: CO2 AMPOC2
5 Temperature (℃) range(25;25;150) Fluid: H2 AMPOC2
6 Temperature (℃) range(25;25;150) Fluid: CO2 AMPOC2
7 Material H2 CO2 CH4 N2 He Vel_in: 1e-3 m/s SS-121
8 Material H2 CO2 CH4 N2 He Vel_in: 1e-3 / slip walls SS-121
9 Velocity (m/s) 1e-4 1e-3 1e-2 0.1 0.5 1 Vel_in: 1e-3 / no slip walls SS-121

10 Velocity (m/s) 1e-4 1e-3 1e-2 0.1 0.5 1 Fluid: CO2 SS-121
11 Temperature (℃) range(25;25;150) Fluid: H2 SS-121
12 Temperature (℃) range(25;25;150) Fluid: CO2 SS-121

ESTUDIO PARAMÉTRICO
• Parametric Sweep of the inlet velocity for the values: 1E-3, 

1E-2, 0.1, 0.2, 0.35 and 0.5 m/s.
• Parametric Sweep of the fluid temperature from 25 ºC up 

to 150 ºC every 25 ºC



ECUACIONES DE NAVIER-STOKE PARA FLUJO DE FLUIDO A ESCALA DE PORO

CONDICION DE DESLIZAMIENTO EN LAS PAREDES 

Teoría

Dependiente del tiempo
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𝜕𝜌
𝜕𝑡 + ∇ & 𝜌𝒖 = 0

∇ & 𝜌𝒖 = 0

𝜌
𝜕𝒖
𝜕𝑡 + 𝜌 𝒖 & ∇ 𝒖 = ∇ & −𝑝𝑰 + 𝑲 + 𝑭

En estado estacionario𝜌 𝒖 & ∇ 𝒖 = ∇ & −𝑝𝑰 + 𝑲 + 𝑭

CONSERVACIÓN DE MASA CONSERVACIÓN DE MOMENTO

−𝑝𝑰 + 𝜇 ∇𝒖 + ∇𝒖 ! 𝒏 = 0

𝒖 & 𝒏 = 0 Sin deslizamiento

Considerando fuerzas viscosas (deslizamiento)



REGÍMENES DE FLUJO DE GASES EN MEDIOS POROSOS SEGÚN EL NÚMERO DE KNUDSEN

Teoría
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𝐾𝑛 =
𝜆

𝐿1234

𝜆 =
𝑘𝑇

4𝜋 2𝑟"𝑝

Geometry Kn_H2 Kn_CO2 Lc	(m) Flow model
AMPC2 0.019 0.012 4.00E-05 Continous to transition region, Navier-Stokes with slip condition
SS-121 0.075 0.047 9.90E-06 Continous to transition region, Navier-Stokes with slip condition



PROPIEDADES DE TRASPORTE MACROSCÓPICAS

Teoría
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𝜺 =
𝑽𝒑𝒐𝒓𝒆𝒔
𝑽 𝒕𝒐𝒕𝒂𝒍

𝜅 = 𝑢+,-𝜇
𝐿
∆𝑝

𝜅. =
2𝜇𝐿𝑄"𝑃"
𝐴(𝑃/" − 𝑃"")

Porosidad

Permeabilidad absoluta Darcy para líquidos

Permeabilidad absoluta Darcy para gases



ESTUDIO BARRIDO DE MATERIALES PARA MODELO AMPC2 

Resultados 
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ESTUDIO BARRIDO DE MATERIALES PARA MODELO SS-121

Resultados 
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POROSIDAD: 54.8%
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BARRIDO PARAMÉTRICO DE LA VELOCIDAD DE ENTRADA PARA MODELO AMPC2 

Resultados 
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POROSIDAD: 30.9%
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BARRIDO PARAMÉTRICO DE LA VELOCIDAD DE ENTRADA PARA SS-121

Resultados 

Simulation of transport phenomena in porous media to store H2 and/or CO2 capture 26

POROSIDAD: 54.8%
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BARRIDO PARAMÉTRICO DE LA TEMPERATURA DE ENTRADA PARA MODELO AMPC2 

Resultados 
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POROSIDAD: 30.9%
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BARRIDO PARAMÉTRICO DE LA TEMPERATURA DE ENTRADA PARA MODELO SS-121

Resultados 
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POROSIDAD: 54.8%
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• La simulación de flujo de fluidos directa en medios porosos geológicos a escala del poro para dimensiones del 

Volumen Elemental Representativo (REV) es computacionalmente costoso de modelar en COMSOL.

• El uso de un Volumen de Interés (VOI) de menores dimensiones al REV permite el modelado de fujo de fluidos de 

una sola fase a un coste computacional razonable, pero con poca o sin escalabilidad a escala macro (Bulk) si los 

resultados no se combinan con técnicas estocásticas. 

• La geometría VOI de la muestra AMPC2 presenta mejor desempeño en la estimación de las propiedades de 

transporte que la geometría VOI de la muestra SS-121, por lo que la elección del tamaño mínimo del VOI podría 

condicionar la representatividad de las propiedades a escalar con modelos combinados. 

• El estudio del barrido de la velocidad de entrada (tasa de inyección) indica que se mantiene flujo laminar en el medio 

poroso para el hidrógeno gaseoso, mientras que para el dióxido de carbono se debe inyectar a bajas tasas para 

mantener el flujo laminar. 

• El estudio de barrido paramétrico de temperatura (temperatura en el subsuelo) no presenta variaciones para el 

hidrógeno y leve incremento de la presión pero posible alta influencia en el cálculo de la permeabilidad absoluta. 

Conclusiones
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